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Hand powerpoint templates free

I like to think of Microsoft PowerPoint as a test of basic marketing skills. To create a passing presentation, I need to demonstrate design skills, technical literacy, and a sense of personal style. If the presentation has a problem (like an unintended font, a broken link, or unreadable text), then I’ve probably
failed the test. Download Now Even if my spoken presentation is well rehearsed, a bad visual experience can ruin it for the audience. Expertise means nothing without a good presentation to back it up. For starters, grab your collection of free PowerPoint templates below, and use the tips that follow to
perfect your next presentation. No matter your topic, successful PowerPoints depend on three main factors: your command of PowerPoint's design tools, your attention to presentation processes, and your devotion to consistent style. Here are some simple tips to help you start mastering each of those
factors, and don't forget to check out the additional resources at the bottom of this post. How to Make a PowerPoint Presentation A presentation is made up of multiple slides, and now that you know how to make one, you can delve deeper into PowerPoint's capabilities. 1. Open a blank presentation again
or start from one you've already created. If you've already created a presentation, double click the icon to open the existing file. Otherwise, open Microsoft PowerPoint, click "File" in the top left corner, and click "New Presentation." From there, you can follow the prompts to set up a new presentation. 2.
Choose a "theme" or create your own. Microsoft offers built-in themes and color variations to help you design your slides with a cohesive look. To choose from these pre-built themes, choose the "File" tab again, select "New", choose one of the options, and click "Create." Otherwise, you can use
PowerPoint elements, your design sense, and your brand's color palette to make your own "theme." 3. Create a variety of slides for different purposes. You don't want to present the same exact slide, just with different content on it. This would bore your audience. Ensure that you create multiple variations,
accommodating some of the common uses for slides. At minimum, you'll need: A title slide An agenda or table of contents slide A slide that introduces the speaker Various content slides (create different layouts considering what kind of multimedia you'll use) 4. Use the Duplicate Slides feature to save you
time. There's no reason to create these designs over and over again. Now that you have a few to draw from, you can simply duplicate them before inputting your content. Here's how to do that: On the left pane, right click the thumbnail of the slide you want to duplicate. Choose "Duplicate Slide" from the
pop-up menu. This will automatically add a copy of this slide to the presentation. From there, you can customize it for your needs. 5. Add transitions to your slides (optional). Done well, transitions can add a little bit of movement and showmanship to your presentation. PowerPoint has several transitions
built in for you to choose from. To access them, select the "Transitions" tab from the top ribbon. From there, you can select a transition for it to preview on your screen. To customize it further, click "Effect Options" and play with the features to find something that suits your liking. To remove a transition,
select "Transitions" and click "None." 6. Add animations to your slides (optional). Like transitions, animations can add movement, reveal information, and help you underscore the points you want to hit during your speech. To animate an element, follow these steps: Select the element you want animated
by clicking on it. Choose "Animations" from the top ribbon. You'll have the option to choose from several effects displayed in the ribbon. Clicking on one will give you a preview. To customize the animation, select "Effect Options." To remove an animation, click "None" in the ribbon. Some of the ways to
customize animations include: On Click With Previous After Previous Duration Delay These describe how you want the effect to behave, so play around with them until you find an effect that suits your liking. You'll also have the option to move animations around as you edit your slides with the "Reorder
Animation" function in the top ribbon. 7. Save your presentation. Click "File" and "Save", making sure to specify which folder or destination you want your PowerPoint to be stored. 8. Run your presentation. It's always good to do a trial run to ensure that your slides are set up properly and your animations
fire they way you expect them to. To present your PowerPoint, go to the "Slide Show" tab and click "Play from Start". The slide will cover your whole screen, blocking out your desktop and PowerPoint software. This is so your audience (in this case, you for the trial run) is solely focused on the visual
elements of your presentation. 9. Advance the slides. When you're done with one slide and want to show the next in your sequence, click your mouse in presentation mode. This will advance the slide. PowerPoint Style 1. Don’t let PowerPoint decide how you use PowerPoint. Microsoft wanted to provide
PowerPoint users with a lot of tools. But this does not mean you should use them all. Here are some key things to look out for: Make sure that preset PPT themes complement your needs before you adopt them. Try to get away from using Microsoft Office’s default fonts, Calibri and Cambria. Using these
two typefaces can make the presentation seem underwhelming. Professionals should never use PPT’s action sounds. (Please consider your audience above personal preference). PowerPoint makes bulleting automatic, but ask yourself: Are bullets actually appropriate for what you need to do?
Sometimes they are, but not always. Recent PPT defaults include a small shadow on all shapes. Remove this shadow if it's not actually needed. Also, don’t leave shapes in their default blue. 2. Create custom slide sizes. While you usually can get away with the default slide size for most presentations,
you may need to adjust it for larger presentations on weirdly sized displays. If you need to do that, here's how. In the top-left corner, choose "File." Select "Page Setup." Type the height and width of the background you'd like, and click "OK." A dialogue box will appear. Click "OK" again. Your background is
resized! Tip: Resize your slides before you add any objects to them or the dimensions of your objects will become skewed. 3. Edit your slide template design. Often, it's much easier to edit your PowerPoint template before you start -- this way, you don't have design each slide by hand. Here's how you do
that. Select "Themes" in the top navigation. In the far right, click "Edit Master," then "Slide Master." Make any changes you like, then click "Close Master." All current and future slides in that presentation will use that template. 4. Write text with your audience in mind. A significant part of a PowerPoint's
content is text. Great copy can make or break your presentation, so evaluating your written work from a few different angles could make you seem more persuasive. Thinking about how your text is received differentiates good presenters from the best. Typography:  Many people underestimate the
influence of typeface, but choosing the right font is important -- the perception of your font type could influence your audience's impression of you. The right font is an opportunity to convey consistent brand personality and professionalism. Some fonts are seen as clean and professional, but this doesn't
mean they're boring. A common mistake is thinking your font isn't "exciting" enough, which could lead you to choose a font that distracts from your overall message. Source: Workfront That said, you can still use fun and eccentric fonts -- in moderation. Offsetting a fun font or large letters with something
more professional can create an engaging presentation. Above all, be sure you're consistent so your presentation looks the same throughout each slide, so your audience doesn't become distracted by too many disparate fonts. Source: Design Shack 5. Make sure all of your objects are properly aligned.
Having properly aligned objects on your slide is the key to making it look polished and professional. You can manually try to line up your images ... but we all know how that typically works out. You're trying to make sure all of your objects hang out in the middle of your slide, but when you drag them there,
it still doesn't look quite right. Get rid of your guessing game and let PowerPoint work its magic with this trick. How to align multiple objects: Select all objects by holding down "Shift" and clicking on all of them. Select "Arrange" in the top options bar, then choose "Align or Distribute." Choose the type of
alignment you'd like. How to align objects to the slide: Select all objects by holding down "Shift" and clicking on all of them. Select "Arrange" in the top options bar, then choose "Align or Distribute." Select "Align to Slide." Select "Arrange" in the top options bar again, then choose "Align or Distribute."
Choose the type of alignment you'd like. PowerPoint Design 6. Use "Format Menus" to better control your objects' designs. Format menus allow you to do fine adjustments that otherwise seem impossible. To do this, right click on an object and select the "Format" option. Here, you can fine-tune shadows,
adjust shape measurements, create reflections, and much more. The menu that will pop up looks like this: Although the main options can be found on PowerPoint’s format toolbars, look for complete control in the format window menu. Other examples of options available include: Adjusting text inside a
shape. Creating a natural perspective shadow behind an object. Recoloring photos manually and with automatic options. 7. Take advantage of PowerPoint's shapes. Many users don’t realize how flexible PowerPoint’s shape tools have become. In combination with the expanded format options released
by Microsoft in 2010, the potential for good design with shapes is readily available. PowerPoint provides the user with a bunch of great shape options beyond the traditional rectangle, oval, and rounded rectangle patterns, unlike even professional design programs like Adobe Creative Suite or Quark.
Today’s shapes include a highly functional Smart Shapes function, which enables you to create diagrams and flow charts in no time. These tools are especially valuable when you consider that PowerPoint is a visual medium. Paragraphing and bullet lists are boring -- you can use shapes to help express
your message more clearly. 8. Create custom shapes. When you create a shape, right click and press "Edit Points." By editing points, you can create custom shapes that fit your specific need. For instance, you can reshape arrows to fit the dimensions you like. Another option is to combine two shapes
together. When selecting two shapes, right-click and go to the "Grouping" sub-menu to see a variety of options. Combine creates a custom shape that has overlapping portions of the two previous shapes cut out. Union makes one completely merged shape. Intersect builds a shape of only the overlapping
sections of the two previous shapes. Subtract cuts out the overlapping portion of one shape from the other. By using these tools rather than trying to edit points precisely, you can create accurately measured custom shapes. 9. Crop images into custom shapes. Besides creating custom shapes in your
presentation, you can also use PowerPoint to crop existing images into new shapes. Here's how you do that: Click on the image and select "Format" in the options bar. Choose "Crop," then "Mask to Shape," and then choose your desired shape. Ta-da! Custom-shaped photos. Learn more about creating
images for your marketing channels in the video below. 10. Present websites within PowerPoint. Tradition says that if you want to show a website in a PowerPoint, you should just create link to the page and prompt a browser to open. For PC users, there’s a better option. Third party software that
integrates fully into PowerPoint’s developer tab can be used to embed a website directly into your PowerPoint using a normal HTML iframe. One of the best tools is LiveWeb, a third-party software developed independently. By using LiveWeb, you don’t have to interrupt your PowerPoint, and your
presentation will remain fluid and natural. Whether you embed a whole webpage or just a YouTube video, this can be a high-quality third party improvement. Unfortunately, Mac users don’t have a similar option. Agood second choice is to take screen shots of the website, link in through a browser, or
embed media (such as a YouTube video) by downloading it directly to your computer. 11. Try Using GIFs. GIFs are looped animated images used to communicate a mood, idea, information, and much more. Users add GIFs to Powerpoints to be funny or quickly demo a process. It's easy to add GIFs to
your slides. To do so, simply follow these steps: Download and save the GIF you want. Go to the slide you want the GIF on. Go to the "Home" tab, and click either "Insert" or "Picture". From the "Picture" drop-down menu, choose "Picture from File". Navigate to where you saved your GIF and select it.
Then, choose "Insert". To play the animated GIF, click the "Slide Show" tab and then "Play from Current Slide". PowerPoint Process 12. Keep it simple. PowerPoint is an excellent tool to support your presentation with visual information, graphics, and supplemental points. This means  that your powerpoint
should not be your entire presentation. Your slides -- no matter how creative and beautiful -- shouldn't be the star of the show. Keep your text and images clear and concise, using them only to supplement your message and authority.  If your slides have dense and cluttered information, it will both distract
your audience and make it much more likely that you will lose their attention. Nothing in your slides should be superfluous! Keep your presentation persuasive by keeping it clean. There are a few ways to do this: Limit bullet points and text. Avoid paragraphs and long quotes. Maintain "white space" or
"negative space". Keep percentages, graphs, and data super basic. 13. Embed your font files. One constant problem presenters have with PowerPoint is that fonts seem to change when presenters move from one computer to another. In reality, the fonts are not changing -- the presentation computer just
doesn’t have the same font files installed. If you’re using a PC and presenting on a PC, then there is a smooth work around for this issue. (When you involve Mac systems, the solution is a bit rougher. See Tip #11.)Here’s the trick: When you save your PowerPoint file (only on a PC), you should click Save
Options in the "Save As …" dialog window. Then, select the "Embed TrueType fonts" check box and press "OK." Now, your presentation will keep the font file and your fonts will not change when you move computers (unless you give your presentation on a Mac). hand drawn powerpoint templates free.
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